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Opis wybranych programów
Niezależnie od wybranego narzędzia trzymaj się zasady, że korzystasz
z nagłówków, nie wytłuszczenia czcionki. Czyli rozdziały i podrozdziały
muszą być nagłówkami różnego poziomu. To jest konieczne, bo w opar-
ciu o nagłówki tworzona jest struktura dokumentu.

Poniżej opis przekrojowych programów dla różnych etapów pracy.

Tworzenie surowego tekstu – Typora.

Przygotowanie publikacji PDF w standardzie ewentualnego wydruku
na papierze – Affinity Publisher.

Stworzenie od podstaw dokumentu EPUB, który będzie poprawnie
dawał się konwertować na MOBI – Sigil.

Program pobierzesz stąd:

https://typora.io

Składnia Markdown jest podana w menu pod Pomoc→Markdown Refe-
rence.

Typora

Windows / Linux / OS X

RYS. 11 Opcje eksportu
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Jeśli chcesz eksportować do wszystkich formatów widocznych w menu
eksportu potrzebujesz doinstalować Pandoc:

https://pandoc.org/installing.html

Możesz być początkowo przerażony, że to jakiś program dla „geeków”
co to sobie lubią „na co dzień” w konsoli kompilować jądro Linuksa.
Nie, nie jest tak. Typora jest bardzo prostym programem. Przykładowo
jeśli chcesz mieć wytłuszczony tekst a nie pamiętasz poleceń Mark-
down, to zakreślasz tekst i wciskasz dwa klawisze Ctrl + b i gotowe. B
jak bold – intuicyjnie. Wszystko jest dostępne na górnej belce w sek-
cjach Akapit i Format.

Możesz też wejść w Plik→Preferencje, jest tam opcja Wygląd okna.
Sprawdź który bardziej ci pasuje – klasyczny czy uniwersalny, bo bardzo
się różnią, inaczej wygląda program po starcie.

Pomimo tego, że z założenia edytor ma być prosty i do szybkiego pisa-
nia, będziesz mile zaskoczony jak fajnie i kolorowo może wyglądać. Na
stronie programu jest dużo świetnych motywów:

http://theme.typora.io

RYS. 12 Fragment okna programu z wczytanym dokumentem. Wygląda to o wiele
lepiej niż typowy Notatnik

http://theme.typora.io


Podręczna ściąga podstawowych znaczników

Po lewej stronie kod dla Typory, po prawej uzyskany efekt.

Im więcej # tym niższy poziom, maksymalnie 6.

Trzy i więcej znaków - plus Enter tworzy ciągłą linię (separator)

# Nagłówek 1

## Nagłówek 2
Nagłówek 1
Nagłówek 2

**Wytłuszczenie**

*Kursywa*

>cytat

Wytłuszczenie

Kursywa

cytat

--- ........................................................................................................................................

## Lista punktowana

* pierwszy

* drugi

* trzeci

Lista punktowana

• pierwszy

• drugi

• trzeci

## Lista numerowana

1. pierwszy

2. drugi

3. trzeci

Lista numerowana

1. pierwszy

2. drugi

3. trzeci
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RYS. 14 Skalowanie obrazka – składnia jak w HTML bądź z menu programu

Nowy akapit robisz Enterem, ale przejście do kolejnej linii bez
tworzenia nowego akapitu – jak w każdym normalnym edytorze tekstu:
Shift + Enter. Tu jest różnica, w większości edytorów Markdown jest to
klasycznie dwie spacje po sobie, w ostateczności znacznik znany
z HTML: <br />

Kod umieszczasz miedzy znakami ` (ten sposób jest znany z programo-
wania jako backticks lub backquotes). Ten znak nazywa się grawis i w
większości klawiatur jest pod klawiszem Esc, przed 1. Jeżeli to ma być
blok kodu to grawisy muszą być trzy. ``` plus Enter otwiera blok.

Wstawianie obrazka:
![Alternatywny tekst](/ścieżka/obrazek.jpg)

Na przykład:
![Logo M](c:\Portable\writemonkey3\wm3icon.png)

RYS. 13 Wyjście z trybu pisania kodu przez klik w wybierz język widoczny po prawej
stronie poniżej kodu



Program kupisz tutaj:

https://affinity.serif.com/en-gb/publisher/

Nie jest spolszczony.

Zatrzymam się trochę przy temacie składu. Jest pojęcie DTP (z jęz. an-
gielskiego desktop publishing). Składanie książki w istotny sposób róż-
ni się od pisania „w Wordzie”. Pierwsza trudność to rozplanowanie za-
wartości. Rozmawiamy o składzie książek i czasopism, czyli nie piszesz
„jak w Wordzie” ciurkiem, tekst jest podzielony na kolumny. Musi być
dzielony, ponieważ bardzo długie linijki źle się czyta. Przy małym for-
macie książki, dużej czcionce i szerokich marginesach można zrobić
układ jednokolumnowy, ale miej świadomość istnienia zagadnienia.
Kolejna sprawa to ilustracje. Strona ma swoje granice, nieraz się zdarza
że obrazek nie mieści się w kolumnie (wystaje „poza kartkę”). Mógłbyś
go dać do nowej kolumny, ale wtedy na kartce powstanie „dziura”,
„biała plama”, w której nie ma ani obrazka ani tekstu. Dlatego często
daje się podpisy pod ilustracjami, a w tekście odsyłacze do nich (np.
„patrz Rys. 23”) co zwalnia z konieczności kombinowania żeby obrazek
był w miejscu w którym jest powiązana z nim treść. Możesz dać opisy
pod obrazkami, ale są reguły. Na przykład czcionka pod obrazkami ma
być mniejsza jak główna treść, w ostatnim zdaniu w podpisie obrazka
nie dajesz kropki na końcu, numeracja obrazków i podpisy dobrze jest
rozróżnić w czcionce. Rozróżniany jest myślnik od półpauzy.

https://pl.wikipedia.org/wiki/Pauza_i_półpauza

Także cudzysłowy w Polsce są inne niż „na Zachodzie” – mamy „” a nie
"". Dolny margines powinien być szerszy od górnego. I tak dalej, jest
masa zasad o których większość ludzi nie ma pojęcia. To co dla ciebie
będzie „O.K.”, to doświadczony „detepowiec” będzie rwał sobie włosy
z głowy. Z drugiej strony, jeśli nie planujesz druku możesz poszaleć i ła-
mać zasady, wiele e-booków współcześnie ma tak się do książek jak no-
woczesna moda z pokazów do tego jak ubierają się przeciętni ludzie.

Drugi aspekt po rozplanowaniu treści na stronie to łamanie tekstu. Czyli
dzielenie słów i przenoszenie ich do kolejnej linii. Standardem jest
słownik Hunspella, który musisz mieć odpowiedni dla języka polskie-
go. Ma to związek z pisownią i wymową, chodzi o to żeby wyraz był
dzielony sylabami, tak jak się wymawia. Na przykład „po-krzywa” albo
„pokrzy-wa”, a nie np. „pokr-zywa”. Inne zasady to: nie zostawiaj wiszą-
cych spójników („i”, „w” i podobne na końcu linii) ani pojedynczego
słowa w ostatniej linii akapitu, akapity dobrze żeby miały wcięcia, i tak
dalej.

Affinity Publisher

Windows / OS X
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Słownik będziesz musiał doinstalować. Potrzebujesz trzy pliki: pl_PL.dic,
pl_PL.aff oraz hyph_pl_PL.dic. W lokalizacji C:\ProgramData\Affinity\Com-
mon\1.0\Dictionaries utwórz katalog pl_PL i do niego wrzuć te pliki. Zre-
startuj program. Jak program je „zobaczy”, przy edycji dokumentu wy-
bierzesz Polski (Polska) w prawym bocznym panelu w zakładce Character
w sekcji Language, opcjonalne ustawienia dzielenia są w Paragraph.

Tworzenie publikacji

Z górnej belki wybierasz File→New. Pokaże się panel z wyborem forma-
tu dokumentu. Ja wybieram zawsze B5, ale są opcje konkretnych urzą-
dzeń, np. Kindle Fire HD 8,9 czy innych tabletów i smartfonów. Po wy-
borze pojawi się biała kartka – to twój początek pracy. W panelu po
lewej będą zakładki. Zwróć uwagę na Pages (strony) będą tam sekcje
Master Pages (strony wzorcowe, szablony) i Pages (zwykłe strony, twoje
treści). Możesz łatwo zmienić wygląd strony przeciągając myszką sza-
blon na otwarty dokument. Szablony tworzysz sam, to znaczy wypraco-
wany układ strony zapisujesz jako szablon. Najlepiej zacznij od kliknię-
cia w ikonkę Add Master (RYS. 19).

RYS. 15 Poprawne ustawienia dla obsługi
języka polskiego – zakładka Character..
Przy większej ilości zakładek nazwy są wy-
świetlane w skrócie – to dlatego na pierw-
szym obrazku jest Par i Tst, widoczne na dru-
gim jako Paragraph i Text Styles

RYS. 16 W zakładce Paragraph zaptaszkuj Use
auto-hyphenation żeby dzielenie działało już
w trakcie pisania.
Zwróć uwagę na cyfry na drugim obrazku. To
domyślne wartości, które możesz zmienić.
Określają minimalną ilość liter jakie musi
mieć słowo żeby było dzielone, ile może zo-
stać minimalnie liter przed kreską, a ile za
kreską
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RYS. 17 Affinity Publisher – wygląd ogólny programu

RYS. 18 Zbliżenie na część w której tworzysz Pages i Master Pages
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Edytuj tę stronę, będzie twoim szablonem do powtórnego wykorzysta-
nia. Nawet jakMaster Pagewydaje się pozornie pusta – pełni swoją rolę.
U mnie na przykład może to wyglądać na zrzucie że szablony są puste,
ale tam są informacje o użytych czcionkach, odległości między liniami
tekstu, domyślna ramka tekstowa, w ogóle o formatowaniu strony.

To co masz w lewym i prawym panelu – które zakładki są widoczne –
wybierasz z górnej belki: View→Studio. Najważniejsza do rozpoczęcia
pracy z dokumentem jest ikonka literki T na pasku narzędzi po lewej,
tworzysz ramkę tekstową w której piszesz. Istotna w prawym panelu
z kolei jest dla ciebie zakładka Characters, która określa wygląd tekstu.
Jeżeli zapełniłeś ramkę tekstu i chcesz pisać dalej – klikasz w grot strzał-
ki (widoczna na zrzucie). Pojawi się ikonka z literą T, co oznacza że teraz
możesz zakreślić ramkę tekstu. W niej będzie ciąg dalszy tego co piszesz.

RYS. 21 Widoczny czerwony grot strzałki wspominany wyżej.
Symbol oka domyślnie jest przekreślony; przełączenie na „widzące” oko pozwala
zobaczyć poniżej ramki ile jeszcze jest tekstu.

RYS. 19 Dodawanie nowego szablonu
strony (pierwsza ikonka w Master Pages)

RYS. 20 Przejście do menadżera sekcji
publikacji (pierwsza ikonka w Pages)
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Praca na warstwach, mimo że głównie piszesz, jest ważna. Warstwy
dają dużą swobodę w projektowaniu stron publikacji. Przykładowo je-
śli trudno jest ci trafić w jakiś element na stronie możesz go wybrać
w menadżerze warstw (RYS. 24). Tam też przez proste przeciągnięcie my-
szą ustalisz w jakiej kolejności (wierzch-spód) ma się znajdować. Mo-
żesz ustawić przezroczystość wybranych elementów (opcja Opacity), co
pozwala na ich przenikanie się. Powyżej menadżera warstw domyślnie
jest koło barw (RYS. 22), w którym możesz dowolnie wybierać kolor do
użycia. Kolejna zakładka w tej sekcji (RYS. 23) pozwala na odkładanie
próbek kolorów do wykorzystania na później, żeby mieć pod ręką. Po-
niżej menadżera warstw są narzędzia edycji warstw (RYS. 25), pozwalają-
ce na operacje na obiektach, na przykład korektę koloru, balansu bieli,
dodanie cienia, obwódki.

RYS. 22 Koło wyboru kolorów RYS. 23 Próbki kolorów

RYS. 24 Menadżer warstw RYS. 25 Edycja warstw (opcje będą
widoczne po kliknięciu w ikonki)
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Jak ustalić gdzie będą numery stron? W Master Pages oczywiście. Na
początek operuj na dwóch:Master A to okładki,Master B to treść właści-
wa. Możesz zmieniać te nazwy, możesz mieć więcej szablonów, ale za-
cznij tak. Następnie stwórz w Master B małe pole tekstowe, np. w rogu
strony i umieść w nim kursor (kliknij). Teraz wybierz z menu Text→Inser-
t→Fields→Page Number. Wstawi ci symbol #. Ten symbol użyty w sza-
blonie będzie w zwykłych stronach reprezentowany przez liczbę nume-
racji stron.

Jeśli nie chcesz by okładki czy początkowe strony były numerowane
i zliczane do spisu treści kliknij w lewym panelu, tam gdzie masz minia-
turki stron, PPM (prawy przycisk myszy) na wybranej stronie i z pod-
ręcznego menu wybierz opcję Clear Masters.

Jeżeli chcesz żeby numeracja stron biegła od określonej strony użyj Sec-
tion Managera (ikonkę wejścia widać na RYS. 20 – symbol tyciej zakładki
jak w książce, ilustracja do omawianego przykładu – RYS. 27).

Zwróć uwagę, że dla wybranej sekcji drugiej numeracja stron biegnie od
nowa, od strony 1, bo wybrałem Restart page numbered at i nadałem
wartość 1. Gdybym miał wybrane zamiast tego Continue page numbering
to numeracja biegłaby jako ciąg dalszy poprzedniej sekcji. Czyli jeśli na
pierwszych stronach wybrałbym Clear Masters to mimo że numery są
niewidoczne numeracja w nich biegnie normalnie.

Po ustawieniu numeracji w Section Manager musisz użyć opcji Text→Ta-
ble of Contents→Update Table of Contents. To spowoduje wygenerowanie

RYS. 26 Wstawianie numeracji stron w szablonie
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na nowo (odświeżenie) spisu treści. Mogą zniknąć litery z polskimi zna-
kami. Ten sam problem jest przy wyborze formatowaniu nagłówków.
Jest tak ponieważ domyślna dla szablonu w Affinity Publisherze jest
czcionka ArialMT bez polskich znaków diakrytycznych. Co to oznacza
dla ciebie realnie? Że najpierw ustaw strukturę dokumentu (nagłówki
różnego poziomu), potem wygeneruj spis treści i na koniec dopiero
ustaw czcionki polskie. Po to żeby nie robić tego samego wielokroć.
Możesz co prawda edytować style, ale uważam że nie powinieneś na
początku zmieniać domyślnych ustawień, dopiero jak program poznasz
lepiej. Zresztą tak można bez końca, „gdzie stąpnie, tam dróżka”. Opisuję
to co niezbędne, link do samouczków jeszcze będzie.

Jak zrobić indeks. Upewnij się że masz dostęp do zakładki Find and Re-
place. Tam wpisz żądane słowo (RYS. 28). Wyrzuci ci listę wszystkich
miejsc w książce gdzie ono występuje. Dwuklikiem przechodzisz do
tych miejsc. Słowo będzie już zaznaczone, z górnej belki wybierzesz Te-
xt→Index→Insert Index Mark. Tym sposobem masz kontrolę nad tym, któ-
re miejsca znajdą się w indeksie, bo nie wszystkie miejsca z danym sło-
wem warte są indeksowania. Indeks tworzysz w dowolnej ramce tek-
stowej wybierając opcję: Text→Index→Insert Index.

Wiszące spójniki… Na ile to jest dla ciebie ważne, na ile ludzie zwracają
na to uwagę? Niestety Affinity Publisher na dzisiaj nie posiada czegoś
takiego jak GREPw programie InDesign. To narzędzie do wyszukiwania
i zastępowania, ale uwzględniające formatowanie. To chyba nawet dar-
mowy Scribus ma taką możliwość. Może ta funkcja w końcu będzie
w Publisherze, ale na razie spacje niełamiące musisz wstawiać sam. Czy-
li jeśli masz na końcu linii samotne „o” a fragment brzmi „o nas”, to
sklejasz ze sobą te słowa (usuwasz spację) i w nowo powstałym słowie
„onas” wkładasz spację niełamiąca między „o” a „n”. To spowoduje, że
„o” znajdzie się w nowej linii. Opcja jest pod Text→Insert→Spaces and
Tabs→Non-Breaking Space. Sięgając tam za każdym razem wykończył-
byś się psychicznie, używaj skrótu dwuklawiszowego lewy Alt + Spacja.

RYS. 27 Section Manager w omawianym przykładzie
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Niestandardowe znaki są pod Studio→View→Glyph Browser (RYS. 29).

Tworzenie własnych styli to jest coś za co bierz się jak już wstępnie opa-
nujesz program. Pokażę ci na podstawie edycji już istniejącego stylu.
Umieść kursor w słowie, na górnym pasku pokaże się jaki to styl (RYS.
30). Tu jest to Heading 1 czyli nagłówek pierwszego poziomu (najwyż-
szy). Następnie w prawym panelu poszukaj go (będzie podświetlony na
niebiesko) i klikając PPM wybierz z menu polecenie edycji tego stylu
(RYS. 31). Pokaże się panel, w którym najważniejsze opcje są najwyżej
(RYS. 32). Tu jest określone jak dany styl działa, to jeszcze nie jest wygląd.
Ten jest pod Font (RYS. 33). Zauważ, że w Font traits nie jest wyświetlony
aktualny krój czcionki. U mnie był to Regular, przestawiasz na Itallic
(kursywę) albo Bold (wytłuszczenie), brak wyboru pozostawi styl bez
zmian. Zwiększenie czcionki to Font Size na np. 24. W ogóle już na począt-
ku ustal sobie gradację tekstu, jeśli będziesz edytował style, np. 12-16-
20-24 pt. Możesz też używać różnych fontów, nie jest powiedziane że
wszystkie nagłówki muszą być pisane tą samą czcionką.

Jeszcze kwestia eksportu. Do druku najlepsza opcja to PDF (Press Ready),
bo jest i 300 dpi i uwzględnione są spady, ale już np. w wersji elektro-
nicznej możesz przykombinować. Na zrzucie (RYS. 34) jest eksport próbki
książki, widać mniejsze DPI i że eksportuję tylko wybrane strony.

RYS. 28 Wyszukiwanie podaje od razu
kontekst użytego słowa

RYS. 29 Przeglądarka glifów.
Dwuklik pozwala odłożyć do
dolnej linii często używane z nich
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RYS. 30 Wybór sekcji tekstu do edycji stylu

RYS. 31 Przejście do edycji stylu

RYS. 32 Edycja stylu, tu rola w strukturze dokumentu
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RYS. 33 Edycja stylu, tu wygląd czcionki

Opcje All Pages a All Spread działają inaczej, ta druga eksportuje arkusze.
Czyli przykładowo chcąc wyeksportować rozkładówkę dwóch stron do
obrazka wybierzesz zakładkę PNG i ustawienie Current Spread.

Pokazałem ci jak utworzyć dokument, wstawiać tekst i kolejne strony
z nim wsposób ciągły, zrobić poprawną numeracje stron, spis treści i in-
deks, poradzić sobie z wiszącymi spójnikami, wstawiać niestandardowe
znaki, edytować style i eksportować dokument, także we fragmentach.
Na start powinno wystarczyć.

Samouczki w formie filmów są na stronie producenta, przejdziesz do
nich wybierając z menu: Help→Tutorial. Tam są najważniejsze, wszystkie
zaś leżą na YouTube:

https://www.youtube.com/c/AffinityPublisherOfficial/playlists

Affinity ma też program do grafiki wektorowej Designer oraz do zdjęć
Photo. Z omawianym Publisherem tworzą trójcę, trzy programy mogą
pracować jako jedno. Mechanizm nazywa się Personas – nie jest otwie-
rany kolejny program tylko przełącza się interfejs, można płynnie prze-
chodzić między nimi kliknięciem. Na dzisiaj każdy z nich to 240 zł.

RYS. 34 Eksport fragmentu książki do PDF



RYS. 35 Fragment strony Affinity pokazującej możliwości programu Publisher.
Pokazuję jako przykład współczesnego składu. Druk jest drobny. Tekst w kolumnach
nie jest łamany ani justowany. Sekcja tytułowa artykułu zajmuje aż pół strony.
Zdjęcia nie mają odstępów i wychodzą na margines. Numeracja stron pełni funkcję
raczej dopełniającą układ niż użytkową

RYS. 36 Inny przykład z tej samej strony. Zwróć uwagę na podział stron na bloki.
Duże użycie koloru dla ożywienia treści. Widoczne zdjęcie w trakcie skalowania
najpewniej ostatecznie zostanie wystające poza żółte pole. Takie niewyrównanie
symetryczne, a przełamanie granicy, jest zabiegiem ożywiającym układ strony

Zwykły tekst WERSALIKI KAPITALIKI

To jest inicjał

RYS. 37 Zobrazowane niektóre z
użytych określeń DTP

Aa Bb Gg Ss Tt
font bezszeryfowy

Aa Bb Gg Ss Tt
font szeryfowy
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Program najpewniej wziąć stąd:

https://github.com/Sigil-Ebook/Sigil/releases

Sigil

Windows / Linux / OS X

RYS. 38 Sigil w czasie pracy, ten układ okien jest dla mnie optymalny

RYS. 39 Początek tworzenia e-booka w EPUB od zera
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Lewy panel składa się z sekcji:

• Text – tu będą pliki rozdziałów

• Styles – użyte style formatowania tekstu w CSS

• Images – obrazki

• Fonts – czcionki

Analogicznie katalogi Audio, Video, Misc (pozostałe) są na pliki użyte
w publikacji. Najlepiej dołącz je na samym początku pracy.

Jeszcze są pliki określające sposób nawigacji po dokumencie i strukturę
e-booka:

• toc.ncx (NCX – Navigation Control file for XML)

• content.opf (OPF – Open Packaging Format File)

Jeżeli masz wyeksportowany plik HTML musisz go podzielić na części.
W myśl zasady jeden plik HTML to jeden rozdział. Pliki te tworzysz
w panelu po lewej stronie ekranu. Tworzysz nowy plik, wklejasz odpo-
wiedni fragment. Masz możliwość podglądu jak tekst wygląda, czy nie
ma błędów. Spis treści z oryginału nie będzie potrzebny, a wręcz jest
zbędny. Jak już masz całą zawartość książki przeniesioną generujesz spis
treści. Opcja jest wmenu Narzędzia-wygeneruj spis treści w HTML. Powsta-
nie plik o nazwie TOC (Table of Contents). Od ciebie zależy czy dasz go
na początek czy koniec e-booka. Osobno robisz okładkę – plik cove-
r.xhtml.

Pomijając fakt, że dłubiesz w kodzie HTML (gwoli ścisłości to XHTML)
jest dużo przydatnych opcji. Na przykład :

Narzędzia→Ponownie formatuj HTML→Popraw i upiększ HTML.

To spowoduje oczyszczenie kodu i ładne jego sformatowanie, działa to
pięknie. Sigil zresztą na bieżąco zaznacza kolorem błędy, na przykład
niedomknięty znacznik. Świetne jest również to, że znaczniki można
wybierać z menu. Czyli zaznaczysz tekst i klikasz w przycisk w menu
jakie chcesz mieć formatowanie, oszczędza to żmudnego wstawiania
ręcznie znaczników. W praktyce dla ciebie oznacza to też, że punktem
wyjściowym nie musi być HTML. Możesz użyć tekstu w dowolnym
formacie i sobie go kliknięciami sformatować jako XHTML.

Wygląd dokumentu określasz stylami CSS (RYS. 40). Ja np. mam utwo-
rzone trzy: style.css (dla podstawowej treści), sgc-toc.css (dla spisu treści),
sgc-index.css (dla indeksu). O tym jak będzie wyglądać dana strona de-
cydujesz podpinając styl do niej (na RYS. 41 to Łącza do arkuszy stylów).

Menu programu jest po polsku, a każda ikonka po najechaniu wskaźni-
kiem myszki wyświetla opis czym jest, do czego służy dany przycisk,
więc nie będę wciskał tutaj składni HTML.
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RYS. 40 Styl dokumentu w CSS. Górny robiony ręcznie, dolny w programie typu
WYSIWYG. Myślę, że różnica w jakości kodu jest widoczna
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RYS. 42 Panel wyboru właściwości semantycznych. Każda jest opisana

RYS. 41 Dodawanie semantyki. Powyżej widoczne omawiane wcześniej Łącza do
arkuszy stylów
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Wtyczki sobie odpuść, na ile przeglądnąłem je, to program w wersji
podstawowej spełnia moje oczekiwania.

Nie będziemy wnikać w jakieś szczegółowe technikalia, bo na początek
mógłbyś się na tym potknąć, ale warto przybliżyć temat semantyki. Se-
mantyka to powiązanie słowa z jego znaczeniem w użytym kontekście.
W Sigilu to nadawanie poszczególnym częściom dokumentu odpowia-
dającej im roli. Podam przykład.

Masz „Spis treści” – ale to ty wiesz, że jest to spis treści. Czytelnik – wie
jak zobaczy podpis „Spis treści”. Czytnik – nie wie. Dla czytnika to „jakaś
strona”. I teraz, jeśli czytnik ma funkcję skoku do spisu treści w trakcie
lektury, to musi wiedzieć dokąd ma skoczyć.

Jeśli dodałeś semantykę, na liście pojawi się znaczek „zaptaszkowania”.
W przykładzie (RYS. 38) nie jest to widoczne, bo wybrana strona zawie-
rająca tylko jedną dużą ilustrację nie wymaga tego. Nie wszystkie pliki
.xhtml muszą być oznaczone. W moim przykładzie są to:

cover.xhtml – Okładka

TOC.xhtml – Spis treści

0a_notka.xhtml – Strona tytułowa – to są informacje kto jest autorem,
wydawcą, jaki jest tytuł książki, data wydania, ISBN itd.

1_wstep.xhtml – Wprowadzenie [other] – tu jest przedmowa, wprowa-
dzenie o czym jest książka

2_Aikido.xhtml – Tekst – tu jest początek właściwej książki w sensie
pierwszy rozdział

backcover.xhtml – Prawa autorskie – u mnie to tylna okładka na której
dałem swoje zdjęcie, krótki biogram i link do swojego bloga, dlatego
oznaczyłem „prawa autorskie”; u ciebie prawdopodobnie będzie inaczej

Resztę stron oznaczysz wedle uznania, te powyżej uznałem za istotne do
wskazania. Poza cover i TOC możesz dawać dowolne nazwy plikom, ale
bez polskich znaków diakrytycznych.

Sprawdzanie składni EPUB jest w menu w Narzędzia→Sprawdź popraw-
ność składni pliku EPUB, ale najszybciej będzie wcisnąć klawisz F7.

To prosty program, wszystko jest opisane po polsku. Pomimo że pracuje
się z kodem, po załapaniu nie jest to uciążliwe.

Sigil daje ci możliwość utworzenia poprawnego dokumentu EPUB.
Jeżeli wykonasz swoją pracę starannie to późniejsza konwersja na
MOBI jest formalnością.
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Walidator pliku EPUB

Przy przesyłaniu pliku może się zdarzyć, że nie zostanie on zatwierdzo-
ny z powodu błędu. Tu taka typowa sytuacja w Google Play:

Jeśli nie korzystasz z Google Play to walidację przeprowadzisz online.
Jest kilka takich narzędzi, poniżej sprawdzone dokładnie z tym plikiem
ze zrzutu wyżej:
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RYS. 43 PDF przeszedł ale przy EBUB są wątpliwości. Czerwony napis głosi
„Wymagane: popraw plik ePub i prześlij go ponownie”. Po kliknięciu w niego pokaże
się lista błędów

RYS. 44 https://www.ebookit.com/tools/bp/Bo/eBookIt/epub-validator

https://www.ebookit.com/tools/bp/Bo/eBookIt/epub-validator


Przykładowa linijka:

ERROR(RSC-005): ./books/Bo/databases/eBookIt/temp_uploads/
1601757018.epub/OEBPS/Text/back_cover.xhtml(11,59): Error while parsing file:
element "img" not allowed here; expected element "address", "blockquote",
"del", "div", "dl", "h1", "h2", "h3", "h4", "h5", "h6", "hr", "ins", "noscript", "ns:svg", "ol", "p",
"pre", "script", "table" or "ul" (with xmlns:ns="http://www.w3.org/2000/svg")

Wygląda okropnie, ale istotne są tu tylko dwie rzeczy:

• błąd występuje w pliku back_cover.xhtml w 11 linii i dotyczy znaku 59
w kolejności

• element img nie zawiera oczekiwanego elementu – i tu podane są
przykładowe znaczniki

Czyli zagnieżdżenie obrazka, na przykład:

<img alt="okladka_tyl" src="../Images/okladka_tyl.jpg"/>

musisz obudować choćby paragrafem <p></p>

To, że dokument przechodzi walidację pomyślnie, nie wykryto żadnych
błędów ani ostrzeżeń, to nie wszystko. To nie oznacza, że jest odpowied-
nio sformatowany dla urządzenia, na którym będzie wyświetlany.
Sprawdź ten dokument na urządzeniu na który jest przeznaczony, a jeśli
nie posiadasz takiego, to na kilku przeglądarkach.

Zachęcam cię do niekorzystania z gotowych styli CSS, tylko napisania
własnego minimalnego, który będzie zawierał tylko wymagane funk-
cje. I nie wrzucaj pliku w inny edytor EPUB, bo dołoży ci swoich śmie-
ci. Zrób całość w Sigilu, potem walidator, ewentualnie dalsza konwersja
do MOBI, będzie elegancko.
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